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Getting started with TetrUSS on Mac OS X
Craig A. Hunter
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This document is intended to provide a brief introduction to using TetrUSS CFD software on
Mac OS X.  It is essentially a self guided “tour”, designed to familiarize users with TetrUSS.
This document is not intended to serve as training or documentation.  For detailed instruction
in TetrUSS, users are encouraged to attend the TetrUSS training course offered by ViGYAN
in Hampton, Virginia.   Important: Before starting this tour, be sure the TetrUSS software
has been installed and setup according to instructions in the “Release Notes” document.

Welcome to TetrUSS on Mac OS X!  TetrUSS is one of the most advanced CFD tools available,
capable of numerous applications in aerodynamics and fluid dynamics.  Before getting started
with our tour, let’s discuss some of the software that will be used here:

    

   

      

   

GTC (GridToolCocoa) is used to prepare geometries for grid
generation.  Typically, a user will import a geometry (IGES,
Plot3D, or curves) into GTC, and then lay the foundation for
grid generation using VGRID OpenGL.

VGRID OpenGL generates unstructured triangular surface
meshes and unstructured tetrahedral volume grids using the
advancing layer and advancing front methods.

POSTGRID OpenGL completes and repairs grids created by
VGRID OpenGL.  In addition, POSTGRID OpenGL can be
used for grid movement and adaptation.

Preface is a utility preprocessor that prepares grids for use in
the USM3D flow solver.  Among other things, Preface
computes the minimum distance between cells and viscous
surfaces, for use in turbulence modeling.

3D Euler and Navier-Stokes flow solver.  USM3D is geared
towards aerodynamic simulations, but also has a wide range of
applications in fluid dynamics.
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In this introduction, we will walk through the steps of applying TetrUSS to simulate transonic
cruise of a generic “advanced technology fighter” (ATF) aircraft configuration, going from
geometry preparation to grid generation to running the flow solver to postprocessing and
visualizing results.  We are going to start from a pre-defined geometry contained in the GridTool
restart file “atf.rst” located in the “ATF Sample Project” (available for download from the Mac
OS X TetrUSS website or on the TetrUSS installer CD).  It’s a good idea to make an “ATF”
folder somewhere on your hard drive, and copy the restart file into that folder (we’ll write
subsequent files into the same location).  While you’re at it, copy the “atf.inpt” file into your
ATF folder as well.  Keep the original files in a safe place, in case you need to recover them.

To follow the grid generation portion of the tour, at least 80MB of free RAM is required.  To
run the USM3D flow solver, approximately 480MB of free RAM is required.

GTC

To start off, launch GTC from the finder by double-clicking its icon.  Go to the “File” menu,
choose “Open”, and navigate your way to the “atf.rst” file in your ATF folder.  Open the file.
GTC will read in the geometry data, and you’ll see it appear in the main graphics window (which
can be resized to your liking).  Several panels may pop up as well.  Now, place your mouse
pointer in the graphics window.  Combined with movement, the mouse buttons do the following:
left=rotate(x)/rotate(z), middle=zoom/rotate(y), right=translate.  If you do not have a 3-button
mouse, option-click emulates the middle button and control-click emulates the right button.  You
should be able to explore the geometry by mousing around (click “Reset View” on the Viewing
Controls drawer if you get lost).  What you’ll see is a model of half the ATF configuration,
mounted to the X-Z “symmetry” plane inside a box (the box is the flow domain).  Since this is a
symmetric aircraft geometry, we can simulate zero-sideslip flows by using half of the
configuration and flow domain, thereby reducing the problem size and saving time.

Convergence tracking and plotting utility.  histPLOT makes it
easy to follow a solution and see how it is progressing, by quickly
plotting out residual along with selected forces and moments.

Tecplot (optional commercial software) is a plotting and data
visualization tool that can handle large CFD data sets.  It is used to
explore, visualize, and present USM3D results.  You can also use
EnSight or DataTank to visualize USM3D solutions.

Utility that converts USM3D solution files into ASCII or binary
data files in a Tecplot-compatible format.
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The GTC graphics window

You may notice several things in the GridTool model; first, a wireframe of the ATF.  This was
constructed from a CAD definition of the ATF (originally in the form of an IGES file).  To see
the CAD surfaces, you can bring the “Surface Attributes” panel to the front (also accessible from
the “Window” menu).  Use the popup menus in this panel to change the surface attributes;
change the “Selection” popup menu to “All” and “Display” popup menu to “Wireframe”,
“Hidden”, or “Shaded”.  Note that you can change the “Display” popup menu to “Off” to turn off
the surfaces.

Another thing you may notice are yellow (or purple when active) grid “sources”.  These are user-
specified, and intended to govern the grid size and spacing during subsequent grid generation
with VGRID.  There are small sources near the fuselage chine, at the wing tip, and along the
leading and trailing edges.  Large sources are placed near the outer corners of the domain.  A
final thing you may notice are “patches”, shown as blue objects on the ATF surface.  Active
patches have arrows on their boundary, and a normal vector in the center of the patch.  Like
sources, patches are user-defined.  These are setup to strategically divide the CAD geometry into
smaller, geometrically simpler surface components.
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This particular example has already been through many hours of geometry preparation, where a
NASA engineer has taken the raw IGES geometry, patched it up, and specified sources.  This is
the most labor-intensive part of using TetrUSS, and will not be covered here.  This process is
part of the TetrUSS training course, however.

OK, now we’re ready to move onto grid generation.  Go up to the File menu and choose “Save”.
If needed, navigate into your ATF folder.  At the bottom of the save pane, change the file type to
“d3m (VGRID)” (it’s the last option in the popup menu).  Click “Save”.  GTC will create several
new files in your demo folder: atf.d3m, atf.igs, and atf.mapbc.  These files make up what’s
known as a VGRID “project”.

Grid Generation with VGRID OpenGL

After the ATF project is written, go to the “Window” menu in GTC, and select the “Grid
Generation” option near the bottom.  The Grid Generation panel will open, and display the path
of the project you just saved (note that you could also browse to pick a suitable .d3m file
defining another project, or just type it in manually).  Click on the “VGRID” button.  A terminal
window will open up (Terminal.app will launch if needed) and VGRID will start a graphics
window.  When you place your mouse in the window, you should see the cursor turn into a “?”.
This the GLUT (part of OpenGL) interface telling you it’s time to right-click the mouse; do so
now.  Select “Viscous” from the popup menu.

Next, you should see a wireframe of the ATF geometry and flow domain.  As in GTC, the
various mouse buttons will allow you to rotate, zoom, and translate.  If you get lost, press “r” on
the keyboard to reset the view.  When you’re done looking at the wireframe, press the “esc” key
on the keyboard (i.e., the ESCAPE key in the upper left corner).  Notice another “?” pops up, so
right-click.  Tell VGRID to display background grid sources in the popup menu.  It will display
the sources specified in GTC.  Hit “esc” again, and then right-click the mouse and tell VGRID to
display points along patch boundaries (this shows the approximate surface grid distribution along
patch boundaries).

When you’re done looking at the points, hit “esc” one more time, right-click, and tell VGRID to
perform surface triangulation without display.  Action should switch to the terminal, and VGRID
will start computing the surface mesh.  When complete, the graphics window will come to the
front.  You can use the mouse to explore the surface mesh (start by zooming in).  You’ll see the
surface mesh of the ATF and the boundaries of the flow domain.  For easier control, place the
mouse arrow over the ATF fuselage near the symmetry plane, and push the “a” key on the
keyboard to set the center of rotation at that point.  You can toggle the “t” key to switch between
the mesh, the wireframe, and the shaded surface.

When you’re done looking at the surface mesh, press “esc”, right-click, and select “Exit plotting”
from the popup menu.  Right-click again and select “Generate volume grid and show  every
1000 iterations”.  VGRID will begin generating the viscous (boundary layer) grid on the ATF
(you’ll see it growing in layers).  This will happen quickly on a fast Mac.  On a slow Mac, you
can press “s” in the graphics window to toggle graphics off, which will make the grid generation
go faster (hit “s” again to toggle graphics back on).



5

ATF surface mesh in VGRID

When the viscous grid generation is complete, go to the VGRID graphics window, hit “esc”,
right-click, and tell VGRID to save the viscous grid and stop.  VGRID will quit (you can safely
ignore any warning messages VGRID may display in the terminal after it quits).

Now, we need to run VGRID again to generate the volume grid.  You could use the “VGRID”
button in GTC again, but at this point it’s easier to go back to the terminal window (the one that
opened up before) and type “vgrid -i atf” (do not use quotes), followed by a return.  VGRID will
launch again.  Same routine as before: right-click in the graphics window, and select “viscous”.
You can zoom into the wireframe and position the ATF in your view.  Now hit “esc” and you’ll
see the ATF and all the viscous layers.  You can zoom in and explore as desired.

When you’re done looking around, press “esc”, right-click, and select “Exit Plotting”.  Right-
click again, and choose “Generate volume grid and show  every 100 iterations”.  VGRID will
begin growing the volume grid, starting with the smallest cells (near the wing tip – zoom in for a
look).  The volume grid generation process will take several minutes, even on a fast Mac.  As
before, you can use “s” to toggle graphics off in order to improve performance (though it’s fun to
leave graphics on and watch VGRID grow the grid).  VGRID will generate grid until the whole
domain is filled, and then automatically quit.
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Volume grid generation in VGRID

POSTGRID OpenGL

At this point, we need to repair any problems with the grid.  For this, POSTGRID OpenGL is
used.  Back in the terminal, type “postgrid -i atf” and hit return.  Right-click in the graphics
window, and select “viscous”.  Right-click again and select “No grid movement”, and right-click
once more and select “Unstructured grid (.cogsg)”.  When the wireframe appears, re-orient your
view to zoom in on the ATF.  Press “esc”, and right-click.  Choose “Remove 1 layer of cells
(viscous and inviscid portions)” from the popup menu.  Right click again and select “Display
grid pockets”.  POSTGRID will show pockets in the grid which must be repaired.  When you’re
done looking at the pockets, press “esc”, right-click, and select “Yes, generate volume grid on
the fly  every 100 iterations”.

POSTGRID will attempt to close the pockets, and this generally takes several iterations.  In this
case, one more iteration is required.  So, right-click, select “Remove 1 layer of cells (inviscid
portion only)”.  Right-click again, and select “Display grid pockets”.  Press “esc”, right-click,
and select “Yes, generate volume grid on the fly  every 100 iterations”.

After this last iteration, the message “GRID IS COMPLETE!” should appear in the terminal.
Now, you can right-click in the graphics window and select “Write new data  Unformatted
(.cogsg) file”.  When file I/O is complete, hit “esc”, right-click, and select “Quit”.  You will need
to right-click once more and select “Yes, quit”.
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Preparing and Running USM3D

Now, the grid generation is complete, and we can prepare to run the USM3D flow solver.  Step
one is to run “Preface”, which is a preprocessor.  To do this from the command line, just type
“preface atf” and hit return (you could also drag and drop any one of the “atf.*” project files onto
the “Preface” icon in the finder).  Wait about a minute while preface runs in the background.

When preface has finished, you can run the USM3D flow solver to actually simulate flow over
the ATF configuration. You can use the USM3D Droplet application or the terminal as shown
here.  Before using the terminal, check the “Release Notes” document to determine the proper
USM3D executable for your particular computer (here, we’ll assume we have a G5 and use the
usm3d.r4.g5.32 executable).  To start off, type “usm3d.r4.g5.32 -c atf” in the terminal and hit
return.  This should indicate that all required files exist.  Notice that the grid contains about
662,000 cells according to USM3D.  Now, type “usm3d.r4.g5.32 -s atf” in the terminal and hit
return.  USM3D will tell you how much memory is required to run the CFD simulation; this
should be a bit less than 480MB (for single precision, USM3D requires about 720 bytes per cell).

Important: Don’t go any further unless you have 480MB of free RAM!

Once you’re ready to go, type “usm3d.r4.g5.32 atf” in the terminal and hit return.  USM3D will
begin to run.  The “atf.inpt” file is set up to run 5 iterations of the flow solver.  This will take
several minutes, even on a fast Mac.  If you want to obtain a converged solution for this case,
USM3D must be run for 1000 iterations (this takes 6-8 hours using one processor of a dual-
2.0GHz PowerMac G5).  To do this, edit the “atf.inpt” file and change ”ncyc” (in the lower left
corner) to 1000.  Make sure the file is saved with UNIX carriage returns (using standard UNIX
text editors is fine, or something like BBEdit with the UNIX CR option).  Type “usm3d.r4.g5.32
atf” in the terminal and hit return to start the run.

ATF CONFIGURATION - Transonic Cruise - USM3D Version 5.2 Control File
Mach    alpha    beta    ReUe,mil    Tinf,dR    itwall    Tw/Tinf   ipwall
0.75    3.00     0.00    0.0058396   460.0      0         -1.0       0
sref    cref     bref     xmc       ymc       zmc
30600   182.86   198.11   364.6     0.        93.1
impl   dt/cfl1   iramp    cfl2    cflmin    GS_tol
1      -5.       200      100.    5.0        0.005
irest   mstage   iresmth     dqmax    p_break   p_min    limiter
0       3        1           0.25     0.01      0.001    1.
nupdate    nwrest    ipltqn     idiagnos   nodeypl
10         50        2          0          0
iorder  lapl-avg   high-bc      ifds     ivisc     EV_lim
2       2          1            1        3         0.1
ncyc    nengines     compF&M     cldes
1000    0            0           0.

If you decide to bail out of USM3D while it’s running, just hit control-c in the terminal, and it
should interrupt the solution procedure.  A more graceful way to stop the run (which will also
preserve the solution) is to create a text file called “usm3d.stop” in the ATF directory, and
place a “1” (no quotes) on the first line.  The text file needs to have UNIX carriage returns.
To restart or continue a solution in progress, modifications will need to be made to the atf.inpt
file, and these are beyond the scope of this introduction.
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While the solution is running, you can monitor convergence with the “histPLOT” utility.  There
are two ways to do this: 1) from the Finder, you can go into your ATF folder, grab the icon of the
“hist.plt” file, drag it and drop it on the “histPLOT” icon in /Applications/TetrUSS, or 2) open up
a terminal window (the original window we were using is probably tied up while USM3D runs),
change into the “ATF” directory, and type “histplot” at the command line followed by a carriage
return.  Either way, the AquaTerm terminal plotting utility will launch, and histPLOT will
construct several plots tracking convergence.  You’ll see solution residual (logR/Ro), lift
coefficient (CL), drag coefficient (CD), viscous drag coefficient (CDV), pitching moment
coefficient (Cm), turbulence residual (logT/To), and CFL number (CFL).  Essentially, USM3D
needs to run until solution residual has dropped a couple orders of magnitude (each –1 increment
is an order of magnitude in the logR/Ro plot) and the aerodynamic coefficients (CL, CD, Cm,
CDV) level off.  When everything settles out, the solution is said to be “converged”.  Again, this
takes about 1000 iterations for the sample ATF case.

Typical convergence history (residual, CL, CD, Cm) for ATF Case over 1000 iterations
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Postprocessing and Visualization

When the solution has finished, integrated forces and moments for the ATF configuration are
given near the end of the “tet.out” text file (in the form of aerodynamic coefficients in various
axis systems).  You can also take a look at the solution by visualizing and plotting it in Tecplot
for Mac OS X (see www.tecplot.com, where a 14-day trial is available).  To do this, the solution
must first be postprocessed with the “Tet2Tec” utility.  Easiest way to run this is from the Finder.
Go into /Applications/TetrUSS, and double click the “Tet2Tec” icon.  After the utility launches,
set the three popup menus (at the top of the Tet2Tec window) as follows, left to right: Binary,
Surface, Grid/uvw/Cp.  This tells Tet2Tec that we want a binary output file of the surface mesh,
and we want the data to contain the grid (x,y,z points), velocities (u,v,w in 3D), and pressure
coefficient (Cp).  There’s actually a ton of data in the CFD solution, and we’re just extracting a
small subset of it to make things go faster.  You could extract different data variables, and even
look at data in the flowfield around the ATF.

Tet2Tec Utility

Now, click the “Choose Files” button in the Tet2Tec window, and navigate your way to the ATF
folder.  Once you’re there, hold down the command key and click on the following four files to
select them all: atf.bc, atf.cogsg, atf.flo, and atf.mapbc (note that Tet2Tec will ignore any other
files in the ATF folder).  When all four files are highlighted, click the “Choose” button.  Tet2Tec
will process the files and produce an “atf.plt” file suitable for Tecplot.  Tet2Tec will quit
automatically if the “Quit app when finished” checkbox is selected.

We won’t go into specifics about Tecplot here (see Tecplot’s documentation for more details),
other than to discuss the procedure for reading the ATF solution into Tecplot and seeing the
results.  From within Tecplot, go to the “File” menu, choose “Load data from file(s)”, and
navigate to the “atf.plt” file you just created.  Highlight the file, and click “OK”.  While loading,
or afterwards, change the plot type to “3D Cartesian”.  Once the file is loaded, you can
rotate/translate the data set to get the best view.  You should see the unstructured mesh for all
surfaces in the domain; the surface of the ATF, the symmetry plane, and the outer “box”.
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If desired, click the “Zone Style” button and deactivate zones 1 and 2; zone 1 is the symmetry
plane (BC#1, reflection) and zone 2 is the outer box (BC#3, characteristic inflow/outflow).  This
should leave zone 3 (BC#4, viscous surface), which is the ATF itself.  Now, uncheck “Mesh”
and “Boundary” and check “Contour” in the main Tecplot window, then select “Cp” in the
contour dialog.  You should see a plot of pressure coefficient (Cp) on the ATF surface.  From
this point, you could adjust the contour colors and levels, mirror the solution about the X-Z plane
(to produce a full aircraft), and use numerous other capabilities in Tecplot.  These are left up to
the user.

Visualizing surface Cp contours in Tecplot

Summary

We hope this document has provided a useful and informative tour of TetrUSS on Mac OS X!
To learn more about TetrUSS, please see the “Release Notes” document for information about
training.  Due to limited resources, we can only provide ongoing tech support to users who have
taken the TetrUSS training class.  For basic support related to this “Getting Started” tour, contact
the author by e-mail.  In addition, please contact the author if you feel something is in error, if
you have a suggestion/comment, or if you encounter a bug with the software.  Please note that
we are unable to answer basic questions regarding OS X, the terminal, or Tecplot.

For detailed instruction in TetrUSS, users are encouraged to attend the TetrUSS training course
offered by ViGYAN in Hampton, Virginia.  For more information:

http://www.vigyan.com/tetruss_training/
tetruss_training@vigyan.com

(757) 865-1400


